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1 Introduction 

1.1 Purpose of the document 
This Visitor Management System Module Settings and Operation Guide is a reference manual designed 

for Visitor Management System module configuration technicians and operators. This module is part of 

an access control system (ACS) built on the ACFA Intellect Software System.  

This Guide presents the following materials: 

1. general information about the Visitor Management System module; 

2. Visitor Management System module settings; 

3. working with the Visitor Management System module 

1.2 General information about the Visitor Management System module 
The Visitor Management System software module is a component of an ACS built on the ACFA Intellect 

Software System and supports the following actions: 

1. observe employees' and visitors' access to objects using automated access control systems and 

their movement about the objects in accordance with granted access levels; 

2. configure user rights to edit and view departments and employees; 

3. create and configure access levels for individual employees and entire departments; 

4. create templates and stamps for electronic security passes for employees and visitors to 

protected objects. 
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2 Starting and stopping the Visitor Management System software 

module 

2.1 Starting the Visitor Management System software module 
To start the Visitor Management System software module, do the following: 

1. Create a Visitor Management System object based on the Screen object on the Interfaces tab of 

the System Settings dialog (Fig.2.1—1). 

 

Fig.2.1—1 Visitor Management System object 

2. Go to the Visitor Management System object's settings pane (Fig.2.1—2). 

 

Fig.2.1—2 Visitor Management System object's settings pane 

3. Specify the position parameters for the Visitor Management System module's window: 

3.1 Check the Fix position box if you need to keep the module's window in a specific place 

on the desktop (Fig.2.1—3). 



7 
 

 

Fig.2.1—3 Position parameters for the module's window 

3.2  To configure the position of the Visitor Management System software module's window, 

specify the coordinates of the window's upper left corner in the X and Y fields and its 

width and height in the W and H fields(see Fig.2.1—3). 

4. Click the Apply button. 

Performing these actions will result in the Visitor Management System module's window being 

displayed on the screen (Fig.2.1—4). 

Note:  Subsequently, the Visitor Management System software module will be started automatically 

after the ACFA Intellect Software System is started. 

 

Fig.2.1—4 Visitor Management System module's window 

2.2 Stopping the Visitor Management System software module 
To stop the Visitor Management System software module, do one of the following three actions: 

1. Click the  button on the ACFA Intellect Software System's main control panel and select the 

Close all menu item (Fig.2.2—1). 
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Fig.2.2—1 Exiting the Visitor Management System software module 

2. Click the  button in the upper right corner of the Visitor Management System software 

module's window. 

 

Note: After using this method to stop the module, you must restart the ACFA Intellect Software 

System to start the Visitor Management System software module again. 

 

3. Go to the File menu and select Exit (Fig.2.2—2). 

 

Fig.2.2—2 Exiting the Visitor Management System software module 

Note: After using this method to stop the module, you must restart the ACFA Intellect Software 

System to start the Visitor Management System software module again. 
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3 Visitor Management System software module settings 

3.1 Basic settings of the Visitor Management System software module 
The Visitor Management System software module's basic settings are configured as follows: 

1. Go to the Visitor Management System object's settings pane (Fig.3.1—1). 

 

Fig.3.1—1 Visitor Management System object's settings pane 

2. Specify the department access parameters for Visitor Management System operators: 

2.1 Select the access level for viewing departments from the View dropdown list (Fig.3.1—2, 

1, Table 3.1—1). 

 

Fig.3.1—2 Department access parameters 

Table 3.1—1 Access levels for viewing departments 

Access level Description 

All All department properties are viewable 

Some Information about department access levels is unavailable for 
viewing 

No Departments are not viewable 

2.2 Select the access level for editing departments from the Edit dropdown list (Fig.3.1—2, 2, 

Table 3.1—2). 

Table 3.1—2 Access levels for editing departments 
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Access level Description 

All All department properties are editable 

Some Editing department access levels is unavailable 

No No department properties are editable 

2.3 Check the Add box to grant access to add new departments (see Fig.3.1—2, 3). 

2.4 Check the Delete box to grant access to delete departments (see Fig.3.1—2, 4). 

3. Specify the user access parameters for Visitor Management System operators: 

3.1 Select the access level for editing users from the Edit dropdown list (Fig.3.1—3, 1, Table 

3.1—3). 

  

Fig.3.1—3 User access parameters 

Table 3.1—3 Access levels for editing users 

Access level Description 

All All user properties are editable 

Some Editing user access levels is unavailable 

No No user properties are editable 

 

3.2 Check the Add box to grant access to add new users (see Fig.3.1—3, 2). 

3.3 Check the Delete box to grant access to delete users (see Fig.3.1—3, 3). 

4. In the list of departments, check each department that should be available to a Visitor 

Management System module operator (Fig.3.1—4). 

 

Fig.3.1—4 Department selection 

5. In the Access levels field, check each access level that should be available to a Visitor 

Management System module operator (Fig.3.1—5). 

 

Fig.3.1—5 Access level selection 

6. Check the Create users with antipassback box if users should be created with a feature activated 

that monitors double-entry (see Fig.3.1—5). 

7. To enable the ability to view and edit access parameters, check the View access parameters and 

Edit access parameters boxes, respectively (Fig.3.1—6, 1). 
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Fig.3.1—6 Visitor Management System module parameters 

8. Check the Discharge access card box to allow the Visitor Management System module operator 

to close (delete) users' security passes (see Fig.3.1—6, 2). Discharging of the user access cards is 

described in Canceling user cards section. 

9. Check the Print access card box to all the Visitor Management System module operator to print 

security passes from the module's window using the system's default printer (see Fig.3.1—6, 3).  

Note: The utility ARPEdit.exe, which is included with the ACFA Intellect Software System, is used to edit 

the printing format. 

10. Check the Export data and Import data boxes to allow the Visitor Management System module 

operator to import and export data using the integrated ACFA Intellect Software System utilities 

and the corresponding software module (see Fig.3.1—6, 4). 

11. Use the spinbox buttons to specify the number of additional access levels available to the Visitor 

Management System module operator (see Fig.3.1—6, 5). 

12. Check the Set expiry date box if the period of the additional access level should be added and 

taken into account (see Fig.3.1—6, 6). 

13. From the Camera dropdown list, select the video camera that will be used to capture a picture 

for the security pass (Fig.3.1—7, 1). 

 

Fig.3.1—7 Device settings 

14. If the selected video camera is connected through a video gateway, select the gateway from the 

corresponding dropdown list (see Fig.3.1—7, 2). 

15. Select the ACS reader that will be used to read codes from user cards from the Reader dropdown 

list (see Fig.3.1—7, 3). 

16. Check the Confirm card entered by operator box if user card assignments must be confirmed 

(see Fig.3.1—7, 4). 

17. If events occurring in the Visitor Management System software module should be displayed on 

all screens on which a Visitor Management System object has been created, check the Send to 

all screens box (see Fig.3.1—7, 5). 

For example: If users add access cards to the system using the Visitor Management System module and 

an access control reader, and the reader is configured such that operator confirmation of entry is 

required (e.g. the Confirm card entered by operator box is checked), then when the Send to all screens 
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box is checked a window prompting to add will appear on all screens where the Visitor Management 

System module is available. 

18. Click the Apply button. 

This completes the process of configuring the basic settings of the Visitor Management System software 

module. 

3.2 Advanced settings of the Visitor Management System software module 
The Visitor Management System software module's advanced settings are configured as follows: 

1. Go to the Visitor Management System object's settings pane (Fig.3.2—1). 

 

Fig.3.2—1 Visitor Management System object's settings pane 

2. Click the Configure button in the Advanced settings field (see Fig.3.2—1). 

The Advanced settings window will open (Fig.3.2—2). 
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Fig.3.2—2 Advanced settings 

3. In the Viewed fields settings group, configure how fields are displayed on the user pane for 

different departments: 

3.1 On each tab check the box next to the fields to be displayed on the user pane of the 

corresponding department (see Fig.3.2—2, 1). 

Note: If all basic fields or all advanced fields should be displayed, check the All fields and All 

extra fields boxes, respectively. 

3.2 If user access levels should be displayed, check the corresponding box (see Fig.3.2—2, 

1). 

4. If the Scanning documents application in the Visitor Management System module should be 

activated, check the corresponding box. 

5. Configure the interface of the Scanning documents interface: 

5.1 In the Documents (tabs) settings group, check the boxes next to the actions that the 

Visitor Management System module operator will be allowed perform with documents 

in the Scanning documents application (see Fig.3.2—2, 2). 

5.2 In the Pages (images) settings group, check the boxes next to the actions that the Visitor 

Management System module operator will be allowed perform with images in the 

Scanning documents application (see Fig.3.2—2, 2). 

5.3 To enable the ability to assign a photograph to users from the Scanning documents 

application, check the Assign picture to employee box (see Fig.3.2—2, 2). 

6. Configure the criteria for duplicate records: 

6.1 Check the Set parameters for duplicate records box if Visitor Management System 

module operator should be warned about duplicate user accounts when creating a new 

record (see Fig.3.2—2, 3). 

6.2 Set the radio button to the desired criteria for identifying duplicate records (see 

Fig.3.2—2, 3, Table 3.2—1).Table 3.2—1 

Table 3.2—1 Criteria for duplicate records 

Criteria Description 

Surname only A new record will be considered a duplicate if the user's 
surname matches that of a previously created user. 
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Name only A new record will be considered a duplicate if the user's name 
matches that of a previously created user. 

Patronymic only A new record will be considered a duplicate if the user's 
patronymic matches that of a previously created user. 

Name and surname A new record will be considered a duplicate if the user's name 
and surname match those of a previously created user. 

Full name A new record will be considered a duplicate if the user's full 
name matches that of a previously created user. 

7. To save changes and return to the Visitor Management System object's settings pane, click 

Save (see Fig.3.2—2). 

Note: To return to the Visitor Management System object's settings pane without saving changes, click 

Cancel (see .Fig.3.2—2). 

8. Click Apply on the Visitor Management System object's settings pane. 

This completes the process of configuring the advanced settings of the Visitor Management System 

software module. 

4 Visitor Management System software module interface 

4.1 Basic elements of the Visitor Management System software module 
The Visitor Management System software module's interface consists of three basic elements:  

1. ACS bar (Fig.4.1—1, 1); 

2. Information pane (Fig.4.1—1, 2). 

3. Toolbar (Fig.4.1—1, 3); 

 

Fig.4.1—1 Visitor Management System software module interface 
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4.1.1 ACS bar 

The ACS bar is designed for switching between the sections of the software module. It displays the 

hierarchical department tree. 

The ACS bar supports editing of the department tree by adding, deleting, and renaming departments, if 

the module operator possesses the appropriate rights.  

Switching to any section of the software module changes the information pane. 

4.1.2 Information pane 

The information pane is designed to display and edit existing (created) time zones, access levels, 

holidays, shift schedules, departments, and all users of the selected department.  

4.1.3 Toolbar 

The toolbar is designed to switch between the ACS bar and the search bar. The toolbar also supports the 

following actions: 

1. Start the Scanning documents application. 

2. Start printing a user access card. 

3. Assign a photograph to a user. 

4. Change the appearance of the information pane. 

4.2 Visitor Management System software module interface settings 

4.2.1 Configuration of the appearance of the menu and toolbar 

To configure the appearance of the Visitor Management System software module's menu and toolbar, 

do the following: 

1. Go to the Service menu (Fig.4.2—1). 

 

Fig.4.2—1 Service menu 

2. Select the Setting… menu item (see Fig.4.2—1). 

The Setting window will open (Fig.4.2—2). 
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Fig.4.2—2 Configuration of the appearance of the menu and toolbar 

3. Check the Always show full menu box if all menu items should be shown immediately (see 

Fig.4.2—2, 1). 

4. Check the Show full menu after short delay box if all menu items should be shown after holding 

the mouse cursor over the down button for a while(see Fig.4.2—2, 2). 

5. Check the Highlight rarely used commands box if rarely used menu items should be highlighted 

(see Fig.4.2—2, 3). 

6. Check the Use animation when expanding menu box if the menu should be animated when it 

expands (see Fig.4.2—2, 4).  

7. Check the Show menu shades box if the menu should cast shadows (see Fig.4.2—2, 5). 

8. Click the Reset command usage statistics button to reset menu item usage statistics (see 

Fig.4.2—2, 6). 

9. Check the Large icons in toolbars box if large icons should be used in the toolbar (see Fig.4.2—2, 

7). 

10. Check the Large icons in menu box if large icons should be used in the menu (see Fig.4.2—2, 8). 

11. Check the Show tooltips for commands in toolbars box to display tooltips when the mouse 

cursor hovers over an icon on a toolbar (see Fig.4.2—2, 9). 

12. Check the Show tooltips for commands in menu box to display tooltips when the mouse cursor 

hovers over a menu item (see Fig.4.2—2, 10).  

13. Check the Add keyboard shortcuts to tooltips box to include the keyboard shortcut for actions 

in tooltips (see Fig.4.2—2, 11). 

14. Select the desired menu animation from the Menu output effect dropdown list (see Fig.4.2—2, 

12). 

Note: If animations are not required, select None. 

15. To save any changes made, click the Apply button. 

Note: To cancel your changes, click the Cancel button. 

This completes the process of configuring the appearance of the menu and toolbar. 

4.2.2 Configuration of the Visitor Management System module's window style 

The Visitor Management System module's window style is configured as follows: 

1. Go to the Service menu (Fig.4.2—3). 
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Fig.4.2—3 Service menu 

2. Select the menu item that corresponds to the desired style (see Fig.4.2—3). 

This completes the process of configuring the Visitor Management System module's window style. 

4.2.3 Configuration of the information pane's view 

The information pane's view is configured in three ways: 

1. Using the information pane's context menu: 

1.1 Go to the section of the Visitor Management System software module which is to have 

its view configured by clicking with the mouse on the desired item in the ACS bar. 

1.2 Right-clicking anywhere on the information pane will bring up the context menu 

(Fig.4.2—4). 

 

Fig.4.2—4 Context menu of the information pane 

1.3 Select the View menu item and select the desired view for the information pane from 

the flyout menu (Fig.4.2—4). 

2. Using the toolbar: 

2.1 Go to the section of the Visitor Management System software module which is to have 

its view configured by clicking with the mouse on the desired item in the ACS bar. 

2.2 Click the  button on the toolbar. 

2.3 Select the desired view for the information pane from the dropdown menu (Fig.4.2—5). 
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Fig.4.2—5 Configuration of the information pane's view using the toolbar 

3. Using the menu: 

3.1 Go to the section of the Visitor Management System software module which is to have 

its view configured by clicking with the mouse on the desired item in the ACS bar. 

3.2 Go to the View menu (Fig.4.2—6). 

 

Fig.4.2—6 View menu 

3.3 Select the View menu item and select the desired view for the information pane from 

the flyout menu (see Fig.4.2—6). 

This completes the process of configuring the information pane's view. 

4.2.4 Visitor Management System software module pane display settings 

The display of the Visitor Management System module's panes is configured as follows: 

1. Go to the View menu (Fig.4.2—7). 
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Fig.4.2—7 View menu 

2. To display the menu, put a check next to Menu bar item by clicking on it (see Fig.4.2—7, 1). 

3. To display the menu, put a check next to the Menu bar item by clicking on it (see Fig.4.2—7, 1). 

4. To display the interface style selection pane, put a check next to the Interface bar item by 

clicking on it (see Fig.4.2—7, 1). 

5. To display the status bar below the Visitor Management System module's window, put a check 

next to the Status bar item by clicking on it (see Fig.4.2—7, 2). 

This completes the process of configuring the display of the Visitor Management System software 

module's panes. 

4.2.5 Moving the Visitor Management System software module's panes 

To enable the movement of the Visitor Management System module's panes, put a check next to the 

Allow bar moving by clicking on the corresponding item in the Service menu (Fig.4.2—8). 

 

Fig.4.2—8 Enabling the movement of panes 

Movement of the Visitor Management System software module's panes is configured as follows: 

1. Left-click the pane's header with the mouse. 
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2. While holding down the left mouse button, move the mouse cursor to the desired area of the 

Visitor Management System module's window. 

3. Release the left mouse button. 

Following these steps will result in the pane being moved to the specified location. 

5 Working with the Visitor Management System software module 

5.1 Working with time zones 
In the Visitor Management System software module, a time zone defines the time interval in which 

users access objects. A single time zone can contain several time intervals.  

5.1.1 Creation of a time zone 

A time zone is created as follows: 

1. Go to the Time zones section of the ACS bar (Fig.5.1—1). 

 

Fig.5.1—1 Creation of a time zone 

The information pane will show previously created time zones and the time zone bar will open (Fig.5.1—

2). 

 

Fig.5.1—2 Time zone bar 

2. Click the New button (see Fig.5.1—2, 1). 

Note: This action can also be performed using the information pane's context menu. Right-click on any 

point in the information pane to bring up the context menu and then select the New menu item 

(Fig.5.1—3). 
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Fig.5.1—3 Context menu of the information pane 

3. In the Name field, enter the name of the time zone (see Fig.5.1—2, 2). 

4. Configure the time zone's intervals. For each interval, do the following: 

4.1 In the Beginning column of the table, enter the time interval's start time in HH:MM:SS 

format (see Fig.5.1—2, 3). 

4.2 In the Ending column of the table, enter the time interval's end time in HH:MM:SS 

format (see Fig.5.1—2, 4). 

4.3 To include a day of the week in the time interval, check the box in the corresponding 

column (see Fig.5.1—2, 5). 

4.4 Check the Holidays box to include holidays in the time interval (see Fig.5.1—2, 5). 

5. Click Save to save the time zone (see Fig.5.1—2, 6). 

The completes the process of creating a time zone. 

5.1.2 Editing a time zone 

A time zone is edited as follows: 

1. Go to the Time zones section of the ACS bar (Fig.5.1—4). 

 

Fig.5.1—4 Editing a time zone 

2. Select the desired time zone in the information pane by clicking on it with the left mouse button 

(Fig.5.1—5). 

 

Fig.5.1—5 Selecting a time zone 

3. Go to the time zone bar and make the desired changes. 

4. Save the changes by clicking Save. 

This completes the process of editing a time zone. 
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5.1.3 Deleting a time zone 

A time zone is deleted as follows: 

1. Go to the Time zones section of the ACS bar (Fig.5.1—6). 

 

Fig.5.1—6 Deleting a time zone 

2. Select the desired time zone in the information pane by clicking on it with the left mouse button 

(Fig.5.1—7). 

 

Fig.5.1—7 Selecting a time zone for deletion 

3. Click Delete on the time zone bar. 

Note: This action can also be performed using the Delete item in the information pane's context menu. 

4. Click Yes to confirm the deletion. 

The completes the process of deleting a time zone. 

5.2 Working with shift schedules 

5.2.1 Creation of a shift schedule 

A shift schedule is created as follows: 

1. Go to the Shift work section of the ACS bar (Fig.5.2—1). 

 

Fig.5.2—1 Creation of a shift schedule 

The information pane will show previously created shift schedules and the shift work schedule bar will 

open (Fig.5.2—2). 
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Fig.5.2—2 Shift work schedule bar 

2. Click the New button (see Fig.5.2—2, 1). 

Note: This action can also be performed using the information pane's context menu. Right-click on any 

point in the information pane to bring up the context menu and then select the New menu item 

(Fig.5.2—3). 

 

Fig.5.2—3 Context menu of the information pane 

3. In the Name field, enter the name of the shift schedule (see Fig.5.2—2, 2). 

4. Specify the shift's start date in the Shift start field in DD.MM.YYYY format (see Fig.5.2—2, 3). 

5. Check the Skip holidays box to ignore holidays (see Fig.5.2—2, 4). 

6. In the Shift time spinbox, use the up/down buttons to enter the total number of days in the 

shift schedule, including days off (see Fig.5.2—2, 5). 

Note: The current shift day is displayed in the corresponding field (see Fig.5.2—2, 6). 

7. Configure the shift schedule's workdays. For each day, do the following: 

7.1 In the Shift day column, enter the shift day's index number (see Fig.5.2—2, 7). 

7.2 In the Beginning column of the table, enter the workday's start time in HH:MM:SS 

format (see Fig.5.2—2, 8). 

7.3 In the Ending column of the table, enter the workday's end time in HH:MM:SS format 

(see Fig.5.2—2, 9). 

8. Click Save to save the shift schedule (see Fig.5.2—2, 10). 

This completes the process of creating a shift schedule. 

5.2.2 Editing a shift schedule 

A shift schedule is edited as follows: 

1. Go to the Shift work section of the ACS bar (Fig.5.2—4). 
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Fig.5.2—4 Editing a shift schedule 

2. Select the desired shift schedule in the information pane by clicking on it with the left mouse 

button (Fig.5.2—5). 

 

Fig.5.2—5 Selecting a shift schedule 

3. Go to the shift work schedule bar and make the desired changes. 

4. Save the changes by clicking Save. 

This completes the process of editing a shift schedule. 

5.2.3 Deleting a shift schedule 

A shift schedule is deleted as follows: 

1. Go to the Shift work section of the ACS bar (Fig.5.2—6). 

 

Fig.5.2—6 Deleting a shift schedule 

2. Select the desired shift schedule in the information pane by clicking on it with the left mouse 

button (Fig.5.2—7). 

 

Fig.5.2—7Selecting a shift schedule for deletion 

3. Click Delete on the shift work schedule bar. 

Note: This action can also be performed using the Delete item in the information pane's context menu. 
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4. Click Yes to confirm the deletion. 

This completes the process of deleting a shift schedule. 

5.3 Working with holidays 
Holidays can be included in time zones and shift schedules.  

5.3.1 Assigning holidays 

Holidays are assigned as follows: 

1. Go to the Holidays section of the ACS bar (Fig.5.3—1). 

 

Fig.5.3—1 Assigning holidays 

The pre-holiday bar will open in the information pane (Fig.5.3—2). 

 

Fig.5.3—2 Pre-holiday bar 

2. Enter the dates of the holidays in DD.MM.YYYY format in the Day column (see Fig.5.3—2, 1).  

Note: Holidays must not be duplicated. 

3. To save any changes made, click the Save button (see Fig.5.3—2, 2). 

This completes the process of assigning holidays. 

5.3.2 Deleting holidays 

Holidays are deleted as follows: 

1. Go to the Holidays section of the ACS bar (Fig.5.3—3). 
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Fig.5.3—3 Deleting holidays 

The pre-holiday bar will open in the information pane (Fig.5.3—4). 

 

Fig.5.3—4 Pre-holiday bar 

2. Bring up the holiday context menu (Fig.5.3—5). Do this by left-clicking with the mouse in the 

corresponding table cell. 

 

Fig.5.3—5 Holiday context menu 

3. Select the Delete record menu item (see Fig.5.3—5). 

4. To save any changes made, click the Save button (see Fig.5.3—4, 2). 

This completes the process of deleting holidays. 

5.3.3 Search for holidays by date 

Search for holidays by date as follows: 

1. Go to the Holidays section of the ACS bar (Fig.5.3—3). 
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Fig.5.3—6 Searching for holidays by date 

The pre-holiday bar will open in the information pane (Fig.5.3—4). 

 

Fig.5.3—7 Pre-holiday bar 

2. Bring up the holiday context menu (Fig.5.3—5). Do this by left-clicking with the mouse in the 

corresponding table cell. 

 

Fig.5.3—8 Holiday context menu 

3. Select the Find menu item (see Fig.5.3—5). 

The Search window will open (Fig.5.3—9). 

 

Fig.5.3—9 Search for holidays 

4. Specify the search parameters: 
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4.1 In the Sample field, enter the search query (a complete or partial holiday date) (see 

Fig.5.3—9, 1). 

4.2 Select the direction of holiday search from the View dropdown list (see Fig.5.3—9, 2). 

4.3 Select the search type from the Match dropdown list (see Table 5.3—1, Fig.5.3—9, 3). 

Table 5.3—1 Search types 

Search type Description 

Whole field The search will find holidays with dates that entirely match 
the search query 

Field beginning The search will find holidays with dates that begin with values 
that match the search query 

Any field part The search will find holidays with dates that contain the 
search query 

 

4.4 To perform a case sensitive search, check the corresponding box (see Fig.5.3—9, 4). 

4.5 To perform a field-format sensitive search, check the corresponding box (see Fig.5.3—9, 

5). 

4.6 To search only in the current field (e.g. the field from which the context menu was 

brought up), check the corresponding box (see Fig.5.3—9, 6). 

5. Click the Find button to begin the holiday search (see Fig.5.3—9, 7). 

If no matching dates are found, a message about the unsuccessful search will appear in a popup window 

(Fig.5.3—10). 

 

Fig.5.3—10 Matching holidays not found 

If a matching holiday is found, then a  icon will appear next to it in the list (Fig.5.3—11). 

 

Fig.5.3—11 Matching holiday found 

6. To continue the search, click the Find next button (see Fig.5.3—9, 8). 

7. To end the search and close the search window, click Close (see Fig.5.3—9, 9). 

This completes the process of searching for holidays. 

5.4 Working with access levels 
In the Visitor Management System software module an access level is a set of special restrictions 

defined by users' rights to access and move about a protected object. 
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An access level determines which access point (reader) for a given time zone (shift schedule) will provide 

user access and, if necessary, forward cards to a controller and armed/disarmed for an object.  

5.4.1 Creation of an access level 

An access level is created as follows: 

1. Go to the Access level section of the ACS bar (Fig.5.4—1). 

 

Fig.5.4—1 Access level creation 

The information pane will show previously created access levels and the access level bar will open 

(Fig.5.4—2). 

 

Fig.5.4—2 Access level bar 

2. Click the New button (see Fig.5.4—2, 1). 

Note: This action can also be performed using the information pane's context menu. Right-click on any 

point in the information pane to bring up the context menu and then select the New menu item 

(Fig.5.2—3). 

 

Fig.5.4—3 Context menu of the information pane 

3. In the Name field, enter the name of the access level (see Fig.5.4—2, 2). 

4. In the Access point column of the table, select the reader through which user access will take 

place (see Fig.5.4—2, 3). 

 

Note:  Each reader can only be used once. An error message will appear if you attempt to use a reader 

multiple times. (Fig.5.4—4). 
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Fig.5.4—4 Error message 

5. In the table's Time zone column, select the time zone (or shift schedule) in which access will 

take place through the access point (see Fig.5.4—2, 4). 

6. Check the box in the table's Card transfer column to forward access cards to the controller after 

an access card has been presented by a user (see Fig.5.4—2, 5). 

7. Check the box in the table's Arm column to arm the access point after an access card has been 

presented by a user (see Fig.5.4—2, 5). 

8. Check the box in the table's Disarm column to disarm the access point after an access card has 

been presented by a user (see Fig.5.4—2, 5). 

9. Click Save to save the access level (see Fig.5.4—2, 6). 

This completes the process of creating an access level. 

5.4.2 Editing an access level 

An access level is edited as follows: 

1. Go to the Access level section of the ACS bar (Fig.5.4—5). 

 

Fig.5.4—5 Editing an access level 

2. Select the desired access level in the information pane by clicking on it with the left mouse 

button (Fig.5.4—6). 

 

Fig.5.4—6 Access level selection 

3. Go to the access level bar and make the desired changes. 

4. Save the changes by clicking Save. 

This completes the process of editing an access level. 
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5.4.3 Deleting an access level 

An access level is deleted as follows: 

1. Go to the Access level section of the ACS bar (Fig.5.4—7). 

 

Fig.5.4—7 Deleting an access level 

2. Select the desired access level in the information pane by clicking on it with the left mouse 

button (Fig.5.4—8). 

 

Fig.5.4—8 Selecting an access level for deletion 

3. Click Delete on the access level bar. 

Note: This action can also be performed using the Delete item in the information pane's context menu. 

4. Click Yes to confirm the deletion. 

This completes the process of deleting an access level. 

5.5 Working with departments 

5.5.1 Creation of a department 

There are two ways to create a department in the Visitor Management System software module: 

1. Using the context menu on the ACS bar: 

1.1 Go to the Departments section of the ACS bar (Fig.5.5—1). 

 

Fig.5.5—1 Creation of a department 

1.2 Bring up the context menu by right-clicking on the Departments section (Fig.5.5—2). 
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Fig.5.5—2 Context menu of the Departments section 

1.3 Select Create department and select the desired department type from the flyout menu 

(see Fig.5.5—2). 

This completes the process of creating a department. 

2. Using the information pane's context menu: 

2.1 Go to the Departments section of the ACS bar (Fig.5.5—3). 

 

Fig.5.5—3 Creation of a department 

2.2 Bring up the context menu by right-clicking on any point on the information pane 

(Fig.5.5—4). 

 

Fig.5.5—4 Context menu of the information pane's Departments section. 

2.3 Select the New menu item (see Fig.5.5—4). 

Caution! This method only creates Employee-type departments 

This completes the process of creating a department. 

5.5.2 Assignment of department properties 

Department properties are assigned on the department properties pane. This pane is displayed on the 

ACS bar when selecting any department (Fig.5.5—5). 
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Fig.5.5—5 Department properties pane 

Department properties are assigned as follows: 

1. In the External ID field, enter the department's external identification number (Fig.5.5—6, 1) 

 

Fig.5.5—6 Assignment of department properties 

2. In the Name field, enter the name of the department (see Fig.5.5—6, 2). 

3. Select the department type from the Type dropdown list (see Fig.5.5—6, 3). 

4. Select the department's access level from the Access level dropdown list (see Fig.5.5—6, 4). 
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Note: The number of employees in the department is indicated in the corresponding field (see Fig.5.5—6, 

5). 

5. In the Extra AL fields, specify the department's additional access levels, if any have been set up 

in the software module (see Fig.5.5—6, 6). See also Basic settings of the Visitor Management 

System software module. 

6. Click Save to save the changes (see Fig.5.5—6, 7). 

This completes the process of assigning department properties. 

5.5.3 Building a department hierarchy 

By default, a department is created as a base department, i.e. a parent department. To build a 

hierarchical department structure, change department parents as desired. 

Department parents are changed as follows: 

1. Bring up the context menu of the desired department on the ACS bar or the information pane 

(Fig.5.5—7). 

 

Fig.5.5—7 Department context menu 

2. Select the Change parent... menu item (see Fig.5.5—7). 

The Change department parent window will open (Fig.5.5—8). 

 

Fig.5.5—8 Changing a department parent 

3. Click on the department to be designated the parent department for the selected department 

(see Fig.5.5—8). 
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4. Click ОК (see Fig.5.5—8). 

This completes the process of changing the department parent. 

5.5.4 Department search 

Departments are searched as follows: 

1. Bring up the context menu of the Departments section (Fig.5.5—9). 

 

Fig.5.5—9 Department context menu 

2. Select the Find department... menu item (see Fig.5.5—9). 

The Search window will open (Fig.5.5—10). 

 

Fig.5.5—10 Department search 

3. Enter the complete or partial name of a department in the field (see Fig.5.5—10, 1). 

4. Click the Find button (see Fig.5.5—10, 2). 

If the search is successful, the matching department is selected on the ACS bar. Otherwise, a message 

about the unsuccessful search will appear in a popup window (Fig.5.5—11). 

 

Fig.5.5—11 Unsuccessful search 

This completes the process of searching for a department. 

5.5.5 Sorting the list of departments on the ACS bar 

To sort the list of departments on the ACS bar alphabetically, do the following: 

1. Go to the Departments section of the ACS bar (Fig.5.5—12). 
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Fig.5.5—12 Sorting the list of departments 

2. Bring up the context menu (Fig.5.5—13). 

 

Fig.5.5—13 Context menu of the Departments section 

3. Select the Sort menu item (see Fig.5.5—13). 

This will sort the list of departments alphabetically. 

5.5.6 Deleting a department 

There are two ways to delete a department in the Visitor Management System software module: 

1. Using the context menu on the ACS bar: 

1.1 Go to the Departments section of the ACS bar (Fig.5.5—14). 

 

Fig.5.5—14Deleting a department 

1.2 Bring up the context menu of the department to be deleted (Fig.5.5—15). 

 

Fig.5.5—15 Context menu of the Departments section 
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1.3 Select the Delete menu item (see Fig.5.5—15). 

This completes the process of deleting a department. 

2. Using the information pane's context menu: 

2.1 Go to the Departments section of the ACS bar (Fig.5.5—16). 

 

Fig.5.5—16 Deleting a department 

2.2 In the information pane, bring up the context menu of the department to be deleted 

(Fig.5.5—17). 

 

Fig.5.5—17 Context menu of the information pane's Departments section. 

2.3 Select the Delete menu item (see Fig.5.5—17). 

This completes the process of deleting a department. 

5.6 Working with users 

5.6.1 Creating a user 

A user is created as follows: 

1. On the ACS bar, go to the department in which the user is to be created. 

2. In the information pane, bring up the context menu by right-clicking on any point on any empty 

space in pane (Fig.5.6—1). 

 

Fig.5.6—1 Context menu 

3. Select the New menu item (see Fig.5.6—1). 

The user pane is displayed below the information pane (Fig.5.6—2). 
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Fig.5.6—2 Settings pane 

Note: Depending on the type of department the user belongs to, the user pane will be named as follows: 

Employee bar, Client bar, etc. 

4. Specify the required user properties (see Fig.5.6—2, 1,Table 5.6—1). 

Table 5.6—1 User parameters 

 Field Format Description 
1 Number Text field User number 

2 Personnel Text field User personnel number 

3 External ID Text field User ID in the external database 

4 Surname Text field User's surname 

5 Name Text field User's name 

6 Patronymic Text field User's surname 

7 Passport Text field Passport number 
8 License Text field Driver's license number 

9 Department Dropdown list Department to which the user belongs 

10 Position Text field User's position 

11 Telephone Text field Telephone number  

12 Make Text field Make of user's car 

13 Number Text field User's car number 

14 User locked Checkbox Yes – the user is locked. 
No – the user is active. 

15 Antipassback Checkbox Yes – anti-passback enabled. 
No – anti-passback disabled. 

16 Object code Text field Facility code of the user's access card 

17 PIN Text field PIN code of the user's access card 

18 Card Text field User's access card number 
19 Card lost__times Text field Number of times the user has lost his or her 

access card 

20 Issued by Text field Employee who issued the access card to the 
user 

21 Expiry date Text entry or date selector Date the user's access card expires 

22 Issue date Text entry or date selector Date the access card was issued to the user 
23 Access level Dropdown list User's access level. 

If Group access level is selected, the user is 
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 Field Format Description 

assigned the access level of the department to 
which he or she belongs. 

24 AL assigned by Text field Employee who assigned the access level to the 
user 

25 Temporary AL Dropdown list Temporary access level 

26 From Text entry or date selector Start date for the temporary access level 

27 To Text entry or date selector End date for the temporary access level 

28 From where (visitor bar only) Text field Name of organization to which the visitor 
belongs 

29 To where (visitor bar only) Dropdown list Department being visited 

30 To whom (visitor bar only) Dropdown list Employee being visited 

 

Note 1: The object code and card code of the user's temporary access card are entered in the Object 

code and Card code fields after the main access card's object code and card code, separated by a space. 

Note 2: To display data in the External ID field, check the Export data and Import data on the Visitor 

Management System object's settings pane (Fig.3.1—6, 4). 

5. Go to the Extra tab (Fig.5.6—3). 

 

Fig.5.6—3 Advanced user settings 

6. Specify the advanced user parameters (see Fig.5.6—3, 1). 

Note: The addition of advanced parameters to the user pane is described in Adding additional user 

parameters. 

7. If needed, enter additional user information in the corresponding field (see Fig.5.6—3, 2). 

8. Click the Save button (see Fig.5.6—2, 3). 

This completes the process of creating a user. 

5.6.2 Transferring a user to a different department 

There are two ways to transfer a user from one department to another: 

1. Using the user pane, which opens by double-clicking on the user in the information pane: 
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1.1 From the Department dropdown list, select the department to which the user is to be 

transferred (Fig.5.6—4, 1). 

 

Fig.5.6—4Transferring a user to a different department 

1.2 Click the Save button (see Fig.5.6—4, 2). 

This completes the process of transferring a user from one department to another. 

2. Using the information pane's context menu: 

2.1 Bring up the user context menu (Fig.5.6—5). 

 

Fig.5.6—5 User context menu 

2.2 Select Transfer employee to another department… (seeFig.5.6—5). 

The Transfer employee to another department window will open (Fig.5.6—6). 
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Fig.5.6—6 Transferring a user to a different department 

2.3 Select the department to which the user is to be transferred (see Fig.5.6—6). 

2.4 Click ОК (see Fig.5.6—6). 

This completes the process of transferring a user from one department to another. 

5.6.3 Assigning a photograph to a user 

There are two ways to assign a photograph to a user: 

1. By selecting a photograph from a file. 

2. By capturing a picture from a video camera. 

5.6.3.1 Selecting a photograph from a file 

To select a photograph from a file, do the following: 

1. Go to the user pane and click Assign picture (Fig.5.6—7).  

 

Fig.5.6—7Selecting a photograph from a file 

2. Select the Select picture from file… menu item and select a file with the user's photograph in 

the window that opens (see Fig.5.6—7). 

The selected photograph will subsequently be displayed in the user pane. 

Note: To save changes, click Save on the user pane. 

5.6.3.2 Capturing a picture from a video camera 

To capture a picture from a video camera, do the following: 

1. Go to the user pane and click Assign picture (Fig.5.6—8).  
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Fig.5.6—8 Assigning a user photograph 

2. Select the Take picture from camera… menu item (see Fig.5.6—8). 

The Picture from camera window will open (Fig.5.6—9). 

 

Fig.5.6—9 Capturing a picture from a video camera 

3. Use the Enter button to capture a picture from the video camera (see Fig.5.6—9, 2). 

The captured frame will be displayed in the right side of the window. 

Note: To rotate the image by 90 degrees, check the Flip checkbox (see Fig.5.6—9, 3). 

4. Click the OK button (see Fig.5.6—9, 1). 

The captured picture will subsequently be displayed in the user pane. 

Note: To save changes, click Save on the user pane. 

5.6.3.3 Creating a single photograph database 

The ACFA Intellect Software System supports storing user photographs on several computers. 

The ACFA Intellect Software System's advanced settings utility tweaki.exe is used to create a single 

photograph database. There are two ways to launch the tweaki.exe utility: 

1. From the Windows Start menu: Start ->All Programs ->Intellect ->Utilities ->Advanced settings. 

2. From the Tools folder of the ACFA Intellect Software System's installation directory: <Intellect 

installation directory>\Tools\tweaki.exe . 

To configure the creation of a single photograph database, do the following: 

1. Select the Visitor Management System mode in the Intellect Advanced Setup window 

(Fig.5.6—10, 1). 
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Fig.5.6—10 Creating a single photograph database 

2.  In the System identifier column, enter the names of the computers that will store the 

photographs assigned by a user using the Visitor Management System module (see Fig.5.6—10, 

2). 

Note 1: The specified computers must be connected to the Intellect Server. Detailed information about 

configuring server connections is given in "Intellect Software System: Administrator's Guide". However, 

the Visitor Management System module does not have to be installed on the specified computers. 

Note 2: Only photographs that have been newly added using the Visitor Management System module 

will be placed on the specified computers. Photographs added to the system before the configuration of 

the creation of a single photograph database will not be distributed to these computers. 

Note 3: Photographs will be stored on both the computers specified using the tweaki.exe utility as well as 

the computer from which photographs are added. Added photographs are stored in: <Intellect 

installation directory>\Bmp\Person. 

3. Click the OK button (see Fig.5.6—10, 2). 

This completes the process of configuring the creation of a single photograph database. 

5.6.4 Printing a user access card 

A user access card is printed as follows: 

1. Go to the user pane (Fig.5.6—11).  
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Fig.5.6—11 User pane 

2. Click Print access card (see Fig.5.6—11). 

The Print window will open (Fig.5.6—12). 

 

Fig.5.6—12 Print access card 

3. From the dropdown list, select the template for printing the access card (see Fig.5.6—12, 1). 

Note: Print templates are prepared in the utility ArpEdit, which is included with the Intellect Software 

System in <Intellect installation director>/Tools/Arpedit/. A description of the utility is given in 

ArpEdit.pdf. 

4. Click the Print button (see Fig.5.6—12, 2). 

This completes the process of printing a user access card. 

5.6.5 User search 

Searching for users happens on the search bar, which is brought up by click the  on the ACS bar. 

There are two ways to perform a user search: 

1. Specify the search parameters (Fig.5.6—13): 

 

Fig.5.6—13 Specifying search parameters 

1.1 In the Search for field, enter the word or value to be searched for (see Fig.5.6—13, 1). 
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Note: The search is not case sensitive. 

1.2 From the Search in dropdown list, select the type of departments that will be searched 

(see Fig.5.6—13, 2). 

1.3 From the Field dropdown list, select the field that will be searched (see Fig.5.6—13, 3). 

1.4 Select the search type from the Match dropdown list (see Fig.5.6—13, 4, Table 5.6—2). 

Table 5.6—2 Search types 

Search type Description 

Whole field A search that will find users for which the search field entirely 
matches the value entered in the Find what field. 

Field beginning A search that will find users for which the start of the search 
field matches the value entered in the Find what field. 

Any field part A search that will find users for which the search field 
contains the value entered in the Find what field. 

1.5  In the Maximum size field, enter the maximum number of results to be displayed (see 

Fig.5.6—13, 5).  

1.6 Check the Extra fields box if the search parameters should include other values and 

fields (see Fig.5.6—13, 6). 

1.7 Click Add to add a field (see Fig.5.6—13, 7). 

1.8 From the dropdown list, select the field that will be searched (see Fig.5.6—13, 8). 

1.9 Enter the value that should be contained in the selected additional field (see Fig.5.6—

13, 9). 

1.10 In the Or columns, enter other values that the selected additional field may contain 

(see Fig.5.6—13, 10). 

This completes the process of specifying the search parameters. 

Note: An example of a search with additional parameters is given below. 

The following parameters have been specified for the search: 

a substring search to find the value Ivanov in the Surname field in Employee-type departments. The 

additional field Card and values 4154 and 4122 have been specified. 

Search results:  

the search returns users from Employee-type departments who have a surname that contains Ivanov 

and whose Card field is equal to 4154 or 4122.  

2. Start the search by clicking Find (Fig.5.6—14, 1). 

 

Fig.5.6—14 Starting/stopping a search and specifying new search parameters 

Note: To stop a search, click the Stop button (see Fig.5.6—14, 2). To specify new search parameters, click 

the New button (see Fig.5.6—14, 3). 

After the search has finished, users that match the specified search criteria will be displayed in the 

information pane. The number of matching users will be indicated in the lower left corner of the pane 

(Fig.5.6—15). 
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Fig.5.6—15 Search results 

This completes the process of searching for users. 

5.6.6 Adding additional user parameters 

The Visitor Management System software module supports adding additional user parameters. 

To add additional parameters, add rows to the OBJ_PERSON table and update the ACFA Intellect 

Software System database. 

Caution! The ACFA Intellect Software System must not be running when adding additional fields. 

Additional parameters are added as follows: 

1. Open the ddi.exe utility located in <Intellect installation directory>/Tools/ (Fig.5.6—16). 

 

Fig.5.6—16 ddi.exe 

2. Open intellect.exe.dbi by selecting Open in the File menu (see Fig.5.6—16, 1). 

Attention! This file is currently not included with the ACFA Intellect Software System. Contact ITV 

customer support to receive intellect.exe.dbi. The file should be placed in the ACFA Intellect Software 

System's installation directory. 

3. Go to the DBI tab (see Fig.5.6—16, 2) and select the OBJ_PERSON table (see Fig.5.6—16, 3).  

4. To create a new field fill the row marked with the * (Fig.5.6-17): 
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Fig.5.6—17 Adding a new field 

 

4.1. Enter the field name (see Fig.5.6-17, 1). 

4.2. Select the type of the field being added from the Type dropdown list (see Fig.5.6-17, 2). 

4.3. In the Size field, enter the size in bytes of the field being added (see Fig.5.6-17, 3). 

4.4. In the Description field, enter the name of the field being added, which will be displayed in the 

Visitor Management System software module's window (see Fig.5.6-17, 4). 

5. Add the required number of fields. 

6. Save the changes to file by selecting Save in the File menu (see Fig.5.6—16, 1). 

7. Update the ACFA Intellect Software System database: 

7.1. Open the idb.exe utility located in the ACFA Intellect Software System's installation directory 

(Fig.5.6—18). 
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Fig.5.6—18 idb.exe 

8. Click the Update database button (see Fig.5.6—18, 1). 

9. After the database update is complete, click ОК (see Fig.5.6—18, 2). 

10. Start the ACFA Intellect Software System and the Visitor Management System software module, and 

go to the Extra tab on the user pane (Fig.5.6—19).  

 

Fig.5.6—19 Added parameters 

The added parameters will be displayed in the Visitor Management System software module's window. 

This completes the process of adding additional parameters. 

5.6.7 Scanning user documents 

Scanning user documents is performed in the Scanning documents application. Working with the 

Scanning documents application is described in Working with the "Scanning documents" application. 
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5.6.8 Canceling user cards 

If a user belongs to the Visitors group, his or her access card can be canceled. 

To cancel a visitor's access card, do the following: 

1. Go to the visitor bar (Fig.5.6—20). 

 

Fig.5.6—20 Visitor bar 

2. Click Discharge card (see Fig.5.6—20). 

3. Confirm the cancellation of the access card by clicking Yes (Fig.5.6—21). 

 

Fig.5.6—21 Canceling a card 

As a result, the user will be deleted from the Visitors department. 

This completes the process of canceling a user's access card. 

5.6.9 Deleting a user 

A user can be deleted in two ways: 

1. Using the context menu: 

1.1 In the information pane, bring up the context menu of the user to be deleted (Fig.5.6—

22). 

 

Fig.5.6—22 User context menu 

1.2 Select the Delete menu item (see Fig.5.6—22). 

1.3 Confirm the deletion by clicking Yes (Fig.5.6—23). 
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Fig.5.6—23 Confirming deletion of a user 

This completes the process of deleting a user. 

2. On the user bar: 

2.1 Go to the pane of the user to be deleted (Fig.5.6—24). 

 

Fig.5.6—24 User pane 

2.2 Click Delete (see Fig.5.6—24). 

2.3 Confirm the deletion by clicking Yes (Fig.5.6—25). 

 

Fig.5.6—25 Confirming deletion of a user 

This completes the process of deleting a user. 

5.6.10 Adding user access cards using a reader 

The Visitor Management System software module supports adding permanent and temporary user 

access cards using an access control reader. The reader to be used to add the cards is indicated on the 

Visitor Management System object's settings pane (see Basic settings of the Visitor Management 

System software module). 

To add access cards to a user using an access control reader, do the following: 
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1. Go to the user pane (Fig.5.6—26). 

 

Fig.5.6—26 Employee bar 

2. Insert the access card to be assigned to the user into the selected reader. 

3. If the Confirm card entered by operator box is checked on the Visitor Management System 

object's settings pane, a Visitor Management System dialog will be displayed (Fig.5.6—27). 

 

Fig.5.6—27 Window to confirm card entered by operator 

3.1. Click Yes if the access card being added is temporary. The object code and the card code are 

entered in the corresponding fields after the codes of previously added access cards, 

separated by spaces (see Fig.5.6—26, 1). 

3.2. Click No if the access card being added is permanent. The object code and card code of the 

inserted access card are entered in the corresponding fields on the employee bar in place of 

the previously specified values. 

3.3. Click Cancel to not add the inserted access card to the user. 

4. If the Confirm card entered by operator box is not checked on the Visitor Management System 

object's settings pane, then the object code and card code of the inserted card will be entered in 

the corresponding fields on the employee bar in place of the previously specified values. 

5. Click the Save button (see Fig.5.6—26, 2). 

Note 1: Temporary access cards are deleted manually. 
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Note 2: When working with the ABC integration module, temporary cards are deleted automatically 

when they expire. The "ABC Integration Module Settings and Operation Guide" describes how to 

configure the expiration date of temporary cards for the ABC module. 

This completes the process of adding a card to a user using an access control reader. 

5.7 Working with the "Scanning documents" application 
"Scanning documents" is an Visitor Management System module software application. The application 

runs in a separate window.  

Note: Fullscreen mode is recommended for your convenience when using this application.  

Caution! To use the "Scanning documents" application, you must first connect a scanner, and install 

drivers and software. 

5.7.1 Starting and stopping the application 

To start Scanning documents, click Scan on the user bar (Fig.5.7—1). 

 

Fig.5.7—1 Starting the application 

The application window will open (Fig.5.7—2). 
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Fig.5.7—2 "Scanning documents" application 

To close Scanning documents, click the  button in the upper right corner of the window. 

5.7.2 Scanning user documents 

User documents are scanned as follows: 

1. Go to the control pane (Fig.5.7—3). 

 

Fig.5.7—3 Control panel 
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2. Select the type of document to be scanned from the Document name dropdown list (see 

Fig.5.7—3, 1). 

3. Enter a name template for the output file in the corresponding field (see Fig.5.7—3, 2). 

4. From the dropdown list, select the format for the output file (see Fig.5.7—3, 3). 

5. Click the Add document button (see Fig.5.7—3, 4). 

An appropriately named tab will open on the document type navigation pane (Fig.5.7—4). 

 

Fig.5.7—4 Document type navigation pane 

6. Click Scan to start the scanning application (see Fig.5.7—3, 5). 

Note: If the required document has already been scanned, it can be loaded from a file. To do this, click 

Select from file and indicate the path to the desired file (see Fig.5.7—3, 6). 

After the scanning is complete, an image of the document will be displayed in the document type 

navigation pane (Fig.5.7—5). 

 

Fig.5.7—5 Scanned document 

5.7.3 Adding and deleting document types 

To add a new document type, do the following: 

1. Go to the control pane (Fig.5.7—6). 
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Fig.5.7—6 Control panel 

2. In the Document name field, enter the type of the document being added (see Fig.5.7—6, 1). 

3. Click the Add document button (see Fig.5.7—6, 2). 

The document type will subsequently be available from the dropdown list (see Fig.5.7—6, 1). 

To delete a document type, do the following: 

1. Select the document type to be deleted from the list (see Fig.5.7—6, 1). 

Note: Only types that were previously manually created can be deleted. 

2. Click the Delete document from list button (see Fig.5.7—6, 3). 

The selected document type will then be deleted. 

5.7.4 Editing an image 

Editing a scanned image is performed in the image editor (Fig.5.7—7). 

 

Fig.5.7—7 Image edit window 

Image editing is performed using the image editor's toolbar and context menu (Fig.5.7—8, Fig.5.7—9). 

 

Fig.5.7—8 Toolbar 
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Fig.5.7—9 Image editor's context menu 

Images are edited as follows: 

1. To select a portion of an image, click the  button on the toolbar. 

2. Select the desired portion of the image (Fig.5.7—10). 

  

Fig.5.7—10 Selecting part of an image 

3. Selecting Cut selected from the context menu will leave only the selected portion of the image 

on the screen (Fig.5.7—11). 

 

Fig.5.7—11 Cropping an image 

4. To clear the selection, select the corresponding item in the context menu. 

5. To change the image size within the image editor, move the  slider on 

the toolbar. 
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6. To automatically select the best image size based on screen resolution and window size, click 

the  button on the toolbar. 

7. To switch to image brightness and contrast settings, select Brightness/contrast from the 

context menu or click the  button in the toolbar. 

8. In the Brightness/contrast window that opens, use the sliders to specify the desired image 

brightness and contrast. Then click ОК to save the changes (Fig.5.7—12). 

Note 1: To cancel your changes, click the Cancel button. 

 Note 2: Check the View box to immediately view the changes in the image editor. 

 

Fig.5.7—12 Image brightness/contrast 

9. To rotate the image counterclockwise by 90 degrees, select Rotate ->Rotate 90⁰ left from the 

context menu or click the  button in the control panel. 

10. To rotate the image clockwise by 90 degrees, select Rotate ->Rotate 90⁰ right from the context 

menu or click the  button in the control panel. 

11. To rotate the image by an arbitrary angle, select Rotate ->Rotate image from the context menu 

or click the  button in the control panel. 

12. In the Rotate window that opens, use the slider to specify the desired angle of rotation. Then 

click ОК to save the changes (Fig.5.7—13). 

Note 1: To cancel your changes, click the Cancel button. 

Note 2: Check the View box to immediately view the changes in the image editor. 

 

Fig.5.7—13 Rotating an image 

13. To save changes, select Save in the context menu or click Save on the control panel (Fig.5.7—

14). 

Note 1:  To cancel your changes, select Cancel in the context menu or click Cancel on the control panel 

(Fig.5.7—14). 
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Fig.5.7—14 Control panel 

This completes the process of editing an image. 

5.7.5 Assigning a photograph to a user 

A portion of an image or an entire image can be used as a user photograph, e.g. displayed on the user 

bar. 

To assign a photograph to a user, do the following: 

1. Select the desired portion of the image (see Editing an image).  

2. Click Use as Photo on the control panel or select the corresponding item in the editing window's 

context menu. 

The selected portion of the image will subsequently be displayed on the user bar as the user's 

photograph. 

5.7.6 Deleting documents and images 

Documents and images are deleted as follows: 

1. Bring up the image's context menu on the document type navigation pane (Fig.5.7—15). 

 

Fig.5.7—15 Image context menu 

2. Select the Delete menu item (see Fig.5.7—15). 

The selected image will then be deleted. 

3. Go to the document type navigation pane to the tab to be deleted (Fig.5.7—16). 

 

Fig.5.7—16 Document type tabs 

4. Click Delete document on the control panel (Fig.5.7—17). 
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Fig.5.7—17 Control panel 

5. Confirm the deletion by clicking Yes (Fig.5.7—18). 

 

Fig.5.7—18 Confirming deletion 

The tab and all of the images in it will then be deleted. 
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6 Appendix 1. Setting up the visitor management without using the 

"Visitor Management System" window 

6.1 General information on ACFA Intellect objects related to the visitor 

management system  
Some of the ACFA Intellect software objects can be used to set up the visitor management system 

without the Visitor Management System window, namely: 

1. User and Department objects created on the Users tab of the System settings dialog box.  

2. Access level and Time zone (which corresponds both to time zone and shift work in the VMS) 

objects created on the Programming tab of the System settings dialog box.  

Note. Settings panel of the Time zone object is described in the Intellect software. Administrator's Guide 

for  this object is used in the Intellect software not only for setting up the visitor management system but 

also for other purposes. 

Most of the settings in the settings panels of these objects duplicate the respective settings of the 

Visitor Management System objects. Thus, the setting of the listed objects is designed to operate in the 

absence of the Visitor Management System module in the system (if the module is not purchased). 

However, as practice shows, the Visitor Management System module provides a much more user-

friendly interface to perform similar tasks and also has an enhanced functionality, so it is recommended 

to use the Visitor Management System module. 

6.2 Settings panel of the "Department" object 
The picture shows the settings panel of the Department object (Fig. 6.2—1). 

 

Fig. 6.2—1 Settings panel of the Department object 

The table gives the description of the Department object settings (Tab. 6.2—1).  

Tab. 6.2—1 Settings of the Department object 

# 
  

Parameter name Method for setting 
the parameter value 

Parameter 
description 

Default value Value range 

1 Identification number 
field 
 

Automatically Shows the 
identification 
number of the 
Department 
object in the 
system 

- Depends on number of 
Department objects in the 
system 

2 Name field  Enter the value in 
the field 

Sets the name of 
the Department 
object in the 
system 

Department A line representing a 
sequence of any symbols  
(letters, digits, service 
characters apart from > 
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# 
  

Parameter name Method for setting 
the parameter value 

Parameter 
description 

Default value Value range 

and < symbols), not case-
sensitive. 
Number of symbols – 
from 1 to 60. 

3 Disable checkbox  Is set in a checkbox Sets the status 
(enabled/disabled
) of the 
Department 
object in the 
system 

False True - the Department 
object is enabled and in 
use 
False - the Department 
object is disabled and not 
in use 

The Access control group 

4 Access level dropdown 
list 

Is selected in the list Sets the 
department's 
access level 

- The list of Access level 
objects created in ACFA 
Intellect (on the 
Programming tab or via 
the VMS) and also Full 
access and Access 
forbidden levels. 

5 List of access levels Is selected in the list. 
To add a new row in 
the table click left 
mouse button in any 
empty space of the 
table and press 
"down" arrow on the 
keyboard. 

Sets the 
department's 
access level list 

- The list of Access level 
objects created in ACFA 
Intellect (on the 
Programming tab or via 
the VMS)  
 

The "Rubezh" subsystem group 
6 Region dropdown list Is selected in the list Sets the Region 

object for the 
Rubeg-07 ACS 
(discontinued) 

- The list of Region objects 
in the ACFA Intellect 
software 

7 Access level dropdown 
list 

Is selected in the list Sets the access 
level for the 
Rubeg-07 ACS 
(discontinued) 

- The list of Access level 
objects created in ACFA 
Intellect (on the 
Programming tab or via 
the VMS) and also Full 
access and Access 
forbidden levels. 

 

6.3 Settings panel of the "User" object 
The pictures show the settings panel of the User object (Fig. 6.3—1, Fig. 6.3—2). 
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Fig. 6.3—1 Settings panel of the User object The Access control tab. 

 

Fig. 6.3—2 Settings panel of the User object The Access levels tab. 

The table gives the description of the Userobject settings (Tab. 6.3—1). 

Tab. 6.3—1 Settings of the User object 

# Parameter name Method for 
setting the 
parameter value 

Parameter 
description 

Default value Value range 

1 Identification number 
field 

Automatically Shows the 
identification 
number of the User 
object in the system 

- Depends on number of User 
objects in the system 

2 Name Field  Enter the value 
in the field 

Sets the name of 
the User object in 
the system 

User  A line representing a 
sequence of any symbols  
(letters, digits, service 
characters apart from > and < 
symbols), not case-sensitive. 
Number of symbols – from 1 
to 60. 

3 Disable Checkbox  Is set in a 
checkbox 

Sets the status 
(enabled/disabled) 
of the User object 

False True - the User object is 
enabled and in use 
False - the User object is 
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# Parameter name Method for 
setting the 
parameter value 

Parameter 
description 

Default value Value range 

in the system disabled and not in use 

4 Department dropdown 
list 

Is selected in the 
list 

Sets the parent 
Department object 
for this User object 

Name of the 
parent 
Department 
object 

Depends on number of 
Department objects in the 
system 

5 Additional info field Enter the value 
in the field 

Additional user 
information 

- A line representing a 
sequence of any symbols  

The "Rubezh" subsystem group 

6 Rights for region 
management 
dropdown list 

Is selected in the 
list 

Sets the 
permissions for the 
Rubeg-07 ACS 
(discontinued) 
regions 
management 

- 0 - 16 

7 Access level dropdown 
list 

Is selected in the 
list 

Sets the access level 
for the Rubeg-07 
ACS (discontinued) 

- The list of Access level objects 
created in ACFA Intellect (on 
the Programming tab or via 
the VMS) and also Full access 
and Access forbidden levels. 

The Access control tab 

8 User locked checkbox Is set in a 
checkbox 

Is set if the user is 
to be locked. 

False True – the user is locked. 
False – the user is active. 

9 Antipassback checkbox Is set in a 
checkbox 

Is set if the user is 
not allowed to go 
twice through the 
reader in the same 
direction. 

False True – anti-passback enabled. 
False – anti-passback 
disabled. 

10 Object code field Enter the value 
in the field 

Facility code of the 
user's access card 

- Depends on the type of cards 
in use. 

11 PIN field Enter the value 
in the field 

PIN-code of the 
user's access card 

- Depends on the ACS in use 

12 Permanent card field Enter the value 
in the field 

User's access card 
number 

- Depends on the type of cards 
in use. 

13 Temporary card field Enter the value 
in the field 

User's temporary 
access card number 

- Depends on the type of cards 
in use. 

14 Valid till field Enter the value 
in the field 

Date the user's 
access card expires 
(which is specified 
in the Permanent 
card field) 

- Date in DD.MM.YYYY format 

Additional cards table 
Note. In the Visitor Management System, the additional cards are specified separated by spaces after the parameters of the 
main card.  
The functionality of assigning users additional cards is to be supported by the hardware. 

15 Object code field Enter the value 
in the field 

Facility code of the 
user's additional 
access card 

- Depends on the type of cards 
in use. 

16 Card code field Enter the value 
in the field 

Number of the 
user's additional 
access card 

- Depends on the type of cards 
in use. 

The Access levels tab. 

17 Access type dropdown 
list 

Is selected in the 
list 

Sets the way of 
choosing access 
level for user 

- Group - the employee is 
assigned the access level of 
the department  
Access forbidden - the 
employee is not allowed to 
access, even if the 
department assigned a 
different access level, 
allowing access 
Full access - the employee 
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# Parameter name Method for 
setting the 
parameter value 

Parameter 
description 

Default value Value range 

has a full access , even if the 
department assigned a 
restricted access level 
List - the employee is 
assigned a list of access levels 
having priority over the 
department access level. 

18 A.L. dropdown list   Is selected in the 
list 

Can be used if the 
List value is 
selected in the 
Access type list. 
Sets the user's 
access level list 

- The list of Access level objects 
created in ACFA Intellect (on 
the Programming tab or via 
the VMS) 

19 Date1 and Time1 fields Enter the value 
in the field 

Allow to set the 
beginning date of 
the temporary 
access level. 

- Date in DD-MM-YY and time 
in HH:MM:SS format. 

20 Date2 and Time2 fields Enter the value 
in the field 

Allow to set the 
ending date of the 
temporary access 
level. 

- Date in DD-MM-YY and time 
in HH:MM:SS format. 

 

6.4 Settings panel of the Access level object 
The picture shows the settings panel of the Access levelobject (Fig. 6.4—1). 

 

Fig. 6.4—1 Settings panel of the Access level object 

The table gives the description of the Access level object settings (Tab. 6.4—1). 

Tab. 6.4—1 Settings of the Access level object 

# 

 

Parameter name Method for 
setting the 

parameter value 

Parameter 
description 

Default 
value 

Value range 

1 Identification 
number field 

Automatically Shows the 
identification number 
of the Access level 
object in the system 

- Depends on number of Access level 
objects in the system 

2 Name field  Enter the value Sets the name of the Access A line representing a sequence of any 
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# 

 

Parameter name Method for 
setting the 

parameter value 

Parameter 
description 

Default 
value 

Value range 

in the field User object in the 
system 

level  symbols  

(letters, digits, service characters apart 

from > and < symbols), not case-

sensitive. 

Number of symbols – from 1 to 60. 

3 Disable checkbox  Is set in a 
checkbox 

Sets the status 
(enabled/disabled) of 
the Access level 
object in the system 

False True - the Access level object is enabled 
and in use 
False - the Access level object is 
disabled and not in use 

4 Access point 
dropdown list 

Is selected in the 
list 

Card reader through 
which the employees 
are performing access  

- Depends on the readers created in the 
system 

5 Time zone 
dropdown list 

Is selected in the 
list 

Time zone, during 
which the access will 
be allowed through 
the corresponding 
access point 

- Always 
Never 
The list of Time zone objects created in 
the system 
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